# CONTENTS

## Introduction
- About this Manual .............................................. 5
- Release Notes .................................................. 5
- Example Images ............................................... 5
- Installation on Mac OS X ...................................... 5
- Installation on Windows ....................................... 6
- Licensing ......................................................... 6
- About The Foundry ............................................. 8
- About CFC .......................................................... 9

## Getting Started
- Introduction ..................................................... 11
- Quick Key ....................................................... 11

## Basic Keying
- Basic Workflow .................................................. 17
- Screen Colour .................................................... 17
- View ............................................................... 18
- Status .............................................................. 19
- Despill Bias ....................................................... 20

## Advanced Keying
- Screen Colour .................................................... 23
- Despilling ......................................................... 26
- Screen Gain ....................................................... 29
- Screen Balance .................................................. 30
- Clip Levels ........................................................ 31
- View ............................................................... 32
- Status View ....................................................... 33
- Screen Matte ...................................................... 36
- Clip Rollback ..................................................... 36
- Grow & Shrink .................................................... 38
- Despot ............................................................. 38
INTRODUCTION

Welcome to this User Guide for Keylight on After Effects.

Keylight is an Academy award winning blue and green screen keyer. The core algorithm was developed by the Computer Film Company and has been further developed and ported to After Effects by The Foundry.

We hope you enjoy using Keylight.

About this Manual

Use the Quick Key chapter to see how a simple key is pulled using Keylight. The Basic Keying Chapter goes over the most common parameters you’ll need to pull a variety of keys. The Advanced Keying Chapter explains how to tackle difficult keys.

Release Notes

For information on system requirements, new features, improvements, fixed bugs and known bugs & workarounds, see “Appendix A” on page 71.

Example Images

Example blue and green screen images for use with Keylight can be downloaded from our web site www.thefoundry.co.uk

Installation on Mac OS X

To install Keylight on a Mac OS X machine follow these instructions:
Installation on Windows

1. Download Keylight1.2v8_AECS3-mac-universal-release-32-Pro.dmg from www.thefoundry.co.uk and extract the package by double clicking on it.
2. Double click on Keylight1.2v8_AECS3-mac-universal-release-32-Pro.pkg
3. Follow the on screen instructions to install keylight
4. Quit
5. That’s it!

Keylight can be found in the Effect - Keying menu.

Installation on Windows

To install Keylight on a Windows machine follow these instructions:

1. Download and run Keylight1.2v8_AE7.0-win-x86-release-32-Pro.exe from www.thefoundry.co.uk.
2. A window will appear welcoming you to the Keylight Setup. Click Next to continue to the end user license agreement.
3. When the end user license agreement appears, please read it. If you agree, click Yes to continue the installation.
4. Choose the location to install Keylight on your hard disk. To accept the default location, and it is strongly recommended that you do, just click Next to continue.
5. The Keylight plug-in will be installed but not licensed.
6. Click Finish to quit the installer.
7. That’s it!

Keylight can be found in the Effect - Keying menu.

Licensing

Versions of Keylight for After Effects Standard are licensed using FLEXlm from Macrovision. The version of Keylight that
ships with After Effects Professional (AE7 and AECS3) does not require a license key, but will only run on the Professional version.

A node locked license will enable Keylight to work on one particular machine. It is locked to a unique number (lmhostid) on that machine. Node locked licenses do not require additional licensing software to be installed. In particular you do not need a FLEXlm daemon running. You just need the Keylight plug-in and a text file containing the license string. Your license key will look a little like this:

```
INCREMENT keylight_ae_i foundry 1.2 05-jul-2007 uncounted
HOSTID=000ea641d7a1 START=8-nov-2006 SIGN="03C7 5A34 BDE8 D421 6C2B 8111 8151 972A 14E2 C143 4C00 741F 730D 784A D392 B1D9 9C3F 03FC DB2A E432 5EA7"
```

This license string should be put in a text file called foundry.lic in the same directory as the Keylight plug-in.

Important!
The really important bit is that the file has a .lic file extension (make sure there is no hidden file extension has been added for you), that it is a plain text file (not rich text) and that you put the file in the correct directory.

For Windows here is the license key:

```
C:\Program Files\Adobe\Adobe After Effects CS3\Support Files\Plugins\Keylight-1.2\foundry.lic
```

For Mac OS X here is the license key:

```
/Applications/Adobe After Effects CS3/Plug-ins/Keylight-1.2/foundry.lic
```

You can get a temporary trial (demo) or permanent license from our web site www.thefoundry.co.uk or contact The Foundry directly.
About The Foundry

**Imhostid**

To display this number click the About button in the Keylight plug-in. The Imhostid is displayed.

**Further Reading**

For more information on licensing Keylight, moving the license file or working with floating licenses, read the Foundry FLEXlm Tools (FFT) User Guide available to download from our web site.

**About The Foundry**

The Foundry specialises in developing plug-in visual effects for compositing platforms in the film and video industry. Based in London’s Soho, the Foundry has tailored its image processing tools to the needs of post production.

Nuke is an Academy award winning compositor from The Foundry.

Tinder plug-ins have been developed by the Foundry and have been sold to hundreds of users throughout the world. They are available on the leading compositing platforms including Discreet Frame, Avid DS, Shake and Adobe After Effects.

Furnace is a rich collection of image processing tools using motion estimation technology to help compositors tackle common problems when working on films. Plug-ins include wire removal, retiming, rig removal, texture plug-ins, grain management, steadiness and deflicker.

Anvil is a set of colour correction and colour manipulation tools. It was originally developed by Paul Grace at First Art and is now available on a variety of platforms.
About CFC

Visit The Foundry’s web site at www.thefoundry.co.uk for further details.

About CFC

The Computer Film Company (CFC) pioneered the field of digital film compositing and today operates a state of the art film effects facility in London. The company has always invested in research, and maintains the kind of edge that has twice been honoured with Technical Achievement Awards from the Academy of Motion Picture Arts and Sciences.

Visit Framestore-CFC’s web site at www.framestore-cfc.com for further details.
**GETTING STARTED**

**Introduction**

Keylight has been refined over a number of years to make keying quicker and easier while providing a depth to the tools that will tackle even the most challenging shots.

Keylight was first developed by The Computer Film Company to help with difficult keys in feature films. Over the years Keylight has been refined in production on hundreds of films. This pioneering work on digital compositing was honoured with a Technical Academy Award® in 1996.

**Notation**

When we refer to blue screens throughout the text we mean, of course, blue or green screens.

**Quick Key**

Keylight is available from the Effect – Keying menu in After Effects.

Consider this shot from The Saint, pictures courtesy of CFC and Paramount British Pictures Ltd. Figure 1 is the blue screen.

![Figure 1. Blue Screen.](image-url)
screen foreground that should be composited over the background shown in Figure 2.

Figure 2. Background.

If you want to have a go of this shot, you can! The images can be downloaded from our web site and this quick key is also covered in the Tutorial Chapter. See “Tutorial 1: Simple Key” on page 49.

Throughout this user guide we assume a good understanding of After Effects. To perform this quick key, do the following:
1. Create a new composition using SaintFG.tif and SaintBG.tif. Layer the clips with the blue screen over the background as shown in Figure 3.

![Figure 3. Screen Shot showing Saint blue screen.](image)

2. Select the blue screen clip (SaintFG.tif) in the Time Layout window and apply Keylight from the Keying sub-menu of the Effect menu. See Figure 4.

![Figure 4. Apply Keylight from the Effect – Keying menu.](image)
3. The Keylight parameters are shown in Figure 5.

![Figure 5. Keylight Parameters.](image)

4. Select the Screen Colour eye dropper and click on the blue screen in the composition window. A good place to pick is the blue from the back windscreen as this has no reflections. Picking this blue will key the back windscreen perfectly leaving reflections in the side window.

5. That's it. In many cases this is all you will need to do to perform a key, since selecting the screen colour creates a matte and
dispills the foreground. The final composite is shown in Figure 7.

![Figure 7. Final composite.](image)

There are a couple of extra steps that can be taken to fine tune this key and these are discussed in “Tutorial 2: Fine Tuning a Key” on page 54.

Picking the screen colour may be enough for a lot of keys, but there are many more tools within Keylight that can be used to tackle more complicated shots. These are described in later chapters.
**BASIC KEYING**

The following section describes the parameters you need to do basic keying. This will give you enough to tackle most simple keys. A discussion of advanced parameters to fine tune and tackle complex keys can be found in the next chapter.

**Basic Workflow**

The first step is always to pick the Screen Colour. Then view the composite and the screen matte.

If there is blue spill on the composite pick skin tones for the Despill Bias from the foreground actor.

If the background is showing through the foreground or the foreground is showing on the background, you need to improve your matte using the Clip Black and Clip White parameters. In the next chapter we’ll look at ways of doing this with inside and outside masks. See “Inside Mask Tip” on page 42.

**Screen Colour**

The Screen Colour is probably the most important parameter and you should always pick the screen colour before doing anything else. It should be set to the colour of the green or blue curtain behind the foreground object. View the Source image in the Composite window, select the eye dropper and pick the screen colour. Setting the Screen Colour will create a matte – the Screen Matte – and despill the foreground. In some cases this is enough to get a decent key. For more information on Screen Colour see page 23.
Figure 8 shows a well lit blue screen behind an actor. You

![Figure 8. Blue Screen.](image)

should note that repeatedly picking the Screen Colour will override any previous selections. It will not add to previous selections and key more of the image with each click.

**Note**

*You should always pick screen colours from the Source image and not the Final Result.*

**Tip**

It’s worth picking several different blues and for each one viewing the matte and status to judge the key.

**View**

After picking the Screen Colour it’s useful to be able to check the quality of the key by viewing the composite and the
screen matte. You can do this using the View Menu, shown here in Figure 9. The options you’ll use the most are:

- **Screen Matte** - this renders the matte created by picking the screen colour.
- **Status** - this renders an exaggerated view of the mattes so that minor problems are shown clearly.
- **Final Result** - this renders the foreground composited over the background using all mattes, spill and colour corrections.

**Status**

The Status is one of the options in the View menu and shows an exaggerated view of the key so that you can make a more informed decision when refining the composite. Figure 11
shows the Status display after the screen colour has been picked from the image shown in Figure 10. Three colours are displayed. Black pixels show areas that will be pure background in the final composite. White pixels show areas that will be pure foreground. Mid-grey pixels will be a blend of foreground and background pixels in the final composite.

You need grey pixels around the edge of the foreground to get a good key at the foreground edge. However, if there are grey pixels where there should be pure background, you should try to remove these with the Screen Strength, Clip Black or Outside Mask. If you have grey pixels where there should be pure foreground this tells you that parts of the background will show through here and you will need to firm up the foreground with Clip White or an Inside Mask.

Pixels that are a blend between the foreground and background are shown in just one shade of grey. This is done to highlight potential problems with the key. These grey pixels may represent a foreground/background blend of 50/50 or 99/1. No distinction is made as to this ratio.

You may occasionally see other colours in the Status View and these are covered on page 34 in the Advanced Keying Chapter.

**Despill Bias**

Although the foreground is despilled automatically, you may find the need to pull out a little more of the screen colour.
after picking from the image. You can do this with the Bias controls.

Figure 12. Exaggerated blue spill. Figure 13. Despill Bias used to remove the blue spill.

By default the Bias controls are locked together, which in the vast majority of cases, is the best way to use them. See “Despilling” on page 26 in the Advanced keying section for a look at a case where unlinking the bias controls is a good tactic.

Thus, using either bias control colour dropper, pick the predominant foreground colour. In the majority of cases it’s best to pick skin tones from the foreground actor, as viewers tend to be most tuned to colour shifts in these areas.
Advanced Keying

The following section describes the parameters you need to fine tune keys and get the most out of Keylight. Basic parameters covered in the previous chapter may also be covered here in more detail.

Screen Colour

The screen colour represents the colour of the pure blue (or green) screen. The first thing you should do when pulling a key is pick the Screen Colour. This single colour has a primary component, blue or green, and that has a saturation. Once the screen colour has been picked, Keylight analyses all the pixels in the image and compares the saturation of the primary component in each of these pixels with the corresponding saturation of the screen colour, setting the alpha and modifying the colour accordingly.

Tip

Picking different shades of blue or green from the background can give quite different results. It’s worth experimenting with different screen colours if your initial pick didn’t give a good key.
Workflow Tip

It can also be useful to view the Status and Source side by side as shown in Figure 14 so that you can repeatedly pick from one while viewing the result in the other window.

Figure 14. Two Views.

Background Pixel

If the saturation of the pixel in the image is as strong, or greater than the screen colour, then it’ll be a pixel from the

Figure 15. Blue screen pixel set alpha to zero.
blue screen background, and that pixel will be set to completely transparent and black. See Figure 15.

**Edge Pixel**

If the saturation of the pixel is less than the screen colour, then it'll be the edge of the foreground object, and we subtract some of the screen colour from the pixel (de spilling) and set the image to semi-opaque. See Figure 16.

![Figure 16. Edge pixel gives partial alpha.](image)

**Foreground Pixel**

If the primary component in the pixel is not the same as the primary component of the screen colour we have a
foreground pixel, and the alpha is set to completely opaque.

![Figure 17. Foreground pixel gives full alpha.](image)

Note: You should note that the Screen Colour is a single colour. You are not picking lots of colours that are keyed out.

**Despilling**

Although picking the screen colour will remove blue spill, it may not be enough. To despill more use the Despill Bias control. By default this is linked to the Alpha Bias. In the rare case that the screen has been so badly shot that it’s not really blue or green anymore, the alpha bias can be used to get a good key.
**Despill Bias**  
Consider Figure 18 from the film “Merlin”. Pulling a default key from this will give the extreme blue spill around the edges of her hair as shown in Figure 19. To reduce this select the Despill Bias colour and pick skin tones from the foreground image. This result is shown in Figure 20. The alpha channel is shown in Figure 21.

![Figure 18. Original blue screen.](image1)  ![Figure 19. Default key.](image2)

Figure 20. Despill Bias.  
Figure 21. Alpha.

**Alpha Bias**  
You should not normally need to adjust the alpha bias separately to the Despill Bias, but on those rare occasions when your green screen is more red than green it can be used to put things right in what would otherwise be an un-
keyable shot. Consider the image shown in Figure 22. This shot, from the film Executive Decision, is actually a green screen although it doesn’t look it. The colour of the screen in the background is around 28% red, 25% green and 8% blue. This is in fact red, but only just. Note that the pilot in the cockpit is predominantly brown, at around 42% red, 25% green, 15% blue. So a default key from that screen colour would make the foreground transparent (Figure 23) as it is a more saturated red than the red of the screen colour.

Figure 22. Is this the worst green screen you’ve ever seen?

Figure 23. Default key showing the transparency of the foreground.
In this situation, the Alpha Bias can help. View the Source, unlink the Bias controls, then select the Alpha Bias and pick colours from his mask. Now pick the same colours for the Despill Bias. This gives the result shown in Figure 24.

![Figure 24. Alpha Bias and Despill Bias.](image)

**Screen Gain**

The screen gain controls how much of the screen colour is removed to make the screen matte. Increasing this value will key more. For the most part, a better way of improving the matte is using the Clip Black and Clip White controls. Figure 25 shows the Status after picking the screen colour.

![Figure 25. Status after picking the Screen Colour.](image)

![Figure 26. Status showing the increase in Screen Gain.](image)
You can clearly see that parts of the background are grey where they should be black. When compositied you may see faint pixels from the foreground where you should be seeing pure background. Increasing the screen gain will fix this, as shown in Figure 26, but increasing it too much will destroy your good work. Like many keying parameters it’s a balance - not too much, not too little. Increasing the screen gain too much will lead to the background showing through the foreground and edge detail will be destroyed. Figure 28 on page 30 shows this quite well. Note the steering wheel is black when it should be white. If you look at the composite you will see the background showing through here. Also, some of the fine hair detail on the actor, visible in Figure 27, has been eroded in Figure 28.

**Screen Balance**

Saturation is measured by comparing the intensity of the primary component against a weighted average of the two other components. This is where the **Screen Balance** control comes in. A balance of 100% means that the saturation will be measured against the smallest of the other two components in the screen colour.
A balance of 0% means that the saturation will be measured against the larger of the other two components. A balance of 50% will measure the saturation from the average of the other two components.

The appropriate balance point for each image sequence you key will be different depending on the colours in that image. Generally speaking, blue screens tend to work best with a balance of around 95% and green screens with a balance of around 50%. If the key is not working too well with these settings, try setting the balance to about 5%, 50% and 95% and see what works best.

**Clip Levels**

The clip levels are adjusted using two parameters - **Clip Black** and **Clip White**. Any alpha value at or below Clip Black will be set to zero and any alpha value at or above Clip White will be set to 100. Figure 29 shows the original alpha of an image and Figure 30 on page 31 shows the result of clipping it. Notice how the grey areas in the black background have been reduced and that the grey edges have hardened up considerably. When compositing, the Clip Black control can be used to improve the background image if parts of the
foreground are showing through. The Clip White control on the other hand can be used to firm up the centre of the matte, making it less transparent to the background.

**Note** You need to be really careful if you chose to use Clip Black and Clip White that you don’t destroy the edges on your foreground. It is possible to use Clip Rollback to compensate for this.

**View**

After picking the Screen Colour it’s useful to be able to view the key in different ways. You can do this using the View Menu, shown here in Figure 31. Here’s the complete list of options and what they do.

- **Source** – displays the blue or green screen.
- **Source Alpha** – displays the alpha channel embedded in the blue or green screen.
- **Corrected Source** – displays the uncomposited source image with any colour corrections applied.
• Colour Correction Edges – displays the foreground edges as a matte that will be colour corrected using the controls in the Edge Colour Correction folder.
• Screen Matte – displays the matte created as a result of picking the screen colour.
• Inside Mask – displays the mask that firms up the foreground.
• Outside Mask – displays the mask that cleans up the background.
• Combined Matte – displays all the screen matte, inside and outside masks and any source alpha added together. The combined matte is used to composite the foreground over the background layer.
• Status – displays an exaggerated view of the key so you can make a more informed decision on how to improve the result. See “Status View” on page 33.
• Intermediate Result – is used for multipass keying. The alpha is set as per normal, but the RGB values are not modified from the original source image. See “Inside Mask Tip” on page 42.
• Final Result – renders the foreground composited over the image on the background track. This image is premultiplied. In other words, the RGB values of pixels have been multiplied by their corresponding alpha channel values.

**Status View**

The Status View is one of the options in the View menu and shows an exaggerated view of the key so that you can make
a more informed decision when fine tuning the composite.

Figure 32. Green Screen.  
Figure 33. Status.

Figure 33 shows the Status after the screen colour has been picked from the image shown in Figure 32 on page 34. Three colours are displayed. Black pixels represent pure background in the final composite. White pixels are pure foreground and grey pixels are a blend of the foreground and background pixels. The grey is just one colour to highlight any areas that are not pure foreground or background. Grey pixels do not mean the key is poor - the final composite may be fine.

You may occasionally see other colours in the Status View.

Figure 34. Status showing processing of the Screen Matte.  
Figure 35. Result showing Screen Matte Replace Colour.
Figure 34 shows black, white, grey and green pixels. The green pixels are a warning. They show you the parts of the Screen Matte that have changed through processing the matte (clipped, softened or eroded). These areas have had the correct amount of spill removed, but the alpha has subsequently changed and the composite may no longer look right. This can be corrected using the Replace Colour to put back colour in these areas. Figure 35 on page 34 is an extreme example to illustrate the point. The Replace Colour has been set to pure red and you can see that this mirrors the green pixels in the Status View.

Similarly you may see blue pixels in the Status. These

represent processed pixels in the Inside Mask that affect the despill of the foreground. The Replace Colour in the Inside Mask folder will be used to modify these pixels. Another extreme example is shown in Figure 37. The Replace Colour is set to pure yellow and the Replace Method is Hard Colour.

You may also see dark red pixels which indicate areas where an outside mask has been used to reduce the transparency of the image.
Screen Matte

The Screen Matte (Figure 39) is the result of pulling the blue or the green from the image (Figure 38) and making those regions transparent. Once you have done this you will want to firm up the foreground (make it more white) and clean up the background (make it more black). This can be done by processing the Screen Matte.

Clip Rollback

Pulling a Screen Matte (Figure 40) will typically produce lots of transparency (grey) in the matte at the edges. This is good since this is what you need to key hair well. You may also get transparency in the foreground as shown in Figure 41. This is bad as your subject will appear slightly see-through, and
this should be corrected. You can do this with an inside mask shape, or you can use the Clip White parameter to turn these grey pixels white. This cleans up the foreground (Figure 42) but it will also destroy the edge detail you want to keep. This is where Clip Rollback comes in. This is used to put back the edges to restore the detail that was lost. A rather exaggerated clip rollback is shown in Figure 43 to illustrate the point.
Grow & Shrink

This control should not normally be used as eroding the edges can produce a very poor key. However, this parameter allows you to grow (if greater than zero) or shrink (if less than zero) the alpha in the Screen Matte. These controls are sub-pixel accurate.

There is, however, one circumstance where heavy eroding is useful and that is for producing a matte used as an inside mask. See “Inside Mask Tip” on page 42.

Despot

This controls how much to simplify the matte. It coagulates similar regions so that, for example, black specks in the white matte can be absorbed by the surrounding white areas. Increasing the Screen Despot Black will remove isolated spots of black in the white matte. Increasing Screen Despot
White will remove isolated spots of white in the background up to that size.

Colour Replacement

Remember that Keylight does two things – it removes the screen colour to despill the image and generates an alpha (Screen Matte) to composite the foreground over the background layer.

If you then process the Screen Matte, for example, by eroding the matte or changing the clip levels, Keylight will be removing the wrong amount of screen colour from the pixels whose transparency have now changed. The Replace Method instructs Keylight how to deal with such pixels. The Status will display which pixels use a replace method. Those pixels who use a replace method because the Screen Matte processing tools modified the transparency will be green, whilst those pixels whose transparency was modified by the inside mask will be blue. See the Status View on page 34.

There are four options to the replace method, these are:
1. None – the despilled image is left untouched if the alpha is modified.
Inside & Outside Masks

If you can't adequately improve the Screen Matte using the Clip Levels, you can input a mask that defines the foreground or background. The Inside Mask makes the foreground less transparent and the Outside Mask is used to clean up the background that might have bits of the foreground showing through. The outside mask is often used to clean up screens that are not a constant colour or have lighting rigs in shot (Figure 48) by forcing the alpha transparent. The inside mask can be used to keep elements in the foreground that you don't want to lose (an actor's blue eyes in front of a blue background).

Figure 48. Green Screen with lighting rig visible.
These masks should normally be softened to blend into the Screen Matte.

Figure 49 on page 41 shows an After Effects Mask drawn around the lighting rig on the left side of the screen. When this is used as the Outside Mask and the View control set to render the Outside Mask, you will see the image displayed in Figure 50. The outside mask forces that part of the image to be in the background thus keying out the rig. The Screen

Matte shown in Figure 51 shows the matte pulled when the green screen is picked. When the Outside Mask is subtracted from the Screen Matte we get the Combined Matte, shown in
Figure 52. Here you can see the change in the matte that will result in the lighting rig being keyed out in the final composite. If more than one mask is required to remove garbage, then use the masks to create an embedded alpha channel in the image and set the Source Alpha to Normal. See “Source Alpha” on page 42.

Source Alpha

This parameter determines how to deal with any embedded alpha in the original image.

- **Ignore** – this will not use any embedded alpha in the key.
- **Add to Inside Mask** – the embedded alpha is added to the inside mask.
- **Normal** – the embedded alpha is used to key the layer as normal. It is added to Keylight’s screen matte and can be useful if requiring complicated multi-shaped masks to rotoscope out garbage.

Inside Mask Tip

An alternative and very powerful use of the Source Alpha option is to provide a solid inside mask pass-through in multipass keying. In other words you can use Keylight to pull a really harsh eroded matte that can be used to stop print through in a second key that concentrates on the edges. Print through is where the background shows through the foreground in a composite. Here’s how you do it.

1. Apply Keylight to your footage and pick the screen colour.
2. Using Clip White, Clip Black and Screen Shrink/Grow while viewing the Screen Matte, get a very harsh eroded matte as shown in Figure 53.

![Figure 53. Highly eroded matte.](image)

3. Switch the View to Intermediate Result to pass through the RGB channels unaffected with the screen matte in the alpha channel. It looks a bit odd but don’t worry.

4. Now apply a second Keylight and pick the screen colour as normal. Looking at the Status display as shown in Figure 54 you should be able to see the background showing through the foreground white areas.

![Figure 54. Status for default key showing foreground transparency.](image)
5. To fix this we’ll use the harsh matte we pulled in the first key. In the Inside Mask group, switch Source Alpha from Ignore to Add To Inside Mask. The result is shown in Figure 55.

![Figure 55. Status showing improved foreground as a result of adding the harsh matte from the first key.](image)

6. With a good foreground, you can now concentrate on pulling a subtle key for the edges without worrying about the background showing through the foreground. You may also need to use a very rough garbage mask to improve the background particularly for unevenly lit screens.

**Colour Correction**

The Colour Correction parameters allow you to modify the foreground colours in your composite. In particular, reflected blues and greens from the screen can be suppressed.

- **Saturation** – this control will increase or decrease the colour saturation of the image, making colours more or less intense.

- **Contrast** – the contrast is the ratio of brightest tones to the darkest. Increase this value for a contrasty image and decrease it to wash it out.

- **Brightness** – the brightness equates to the overall...
luminance of the image. Increase this value to make the image lighter and decrease this value to make it darker.

**Colour Suppression**

**Suppress** – this controls colour suppression in the image. You can choose to remove a specific primary, either Red, Green, Blue or their complements, Cyan, Magenta or Yellow. For green screens you may find it helpful to suppress green.

**Suppression Balance** – determines what to reduce the suppressed component to. If set to 0%, it will be the smallest of the other two components, if set to 100% it will be the largest of the other two components. Otherwise, it will be to a balanced average.

**Suppression Amount** – determines how strongly you want to reduce the indicated component.

**Colour Balancing**

These controls are used to alter the colour balance of the image. Choose a hue and saturation (either via the sliders or the colour balance wheel) to shift the entire colour balance of the image.

**Edge Colour Correction**

The Edge Correction parameters allow you to colour correct edges to seat the composite into the background. To see the areas considered an edge that you will be affecting, select the Colour Correction Edges from the View menu.

**Enable Edge Colour Correction** – use this option to
separately colour correct edges of the image independently from the overall colour correction.

**Edge Hardness** - this determines how strongly to blend between the edge correction and the main correction.

**Edge Softness** - this will soften the region considered to be the edge by this amount (in pixels).

**Edge Grow** - this will grow the region considered to be the edge by this amount (in pixels).

**Saturation** - these controls determine how much to scale the saturation of the image.

**Contrast** - this control increases/decreases the contrast on the region considered to be the edge.

**Brightness** - this control brightens the region considered to be the edge.

**Edge Colour Suppression**
Controls the colour suppression in the image.

**Suppress** - Choose to completely remove a specific primary, either Red, Yellow, Green, Blue or their components, Cyan, Magenta or Yellow.

**Suppression Balance** - determines what to reduce the suppressed component to. If set to 0%, it will be the smallest of the other two components, if set to 100% it will be the largest of the other two components. Otherwise, it will be to a balanced average.
Suppression Amount – determines how strongly you want to reduce the indicated component.

Colour Balancing
These controls are used to alter the colour balance of the image edges. Choose a hue and saturation (either via the sliders or the colour balance wheel) to shift the entire colour balance of the image.

Source Crops
The Source Crops enable you to quickly cut out lighting rigs or other unwanted elements using vertical and horizontal lines.

Keylight requires access to source pixels that lie off the edge of the source image. The cropping controls provide access to all the controls required for specifying how pixels are treated at these edges and where they appear. The built-in crop controls are also useful for removing unwanted black pixels at the edge of video footage.

X Y Method – determines the behaviour of the image at the left and right crop boundaries. Four edge methods are supplied:
- Colour – fills the area between the crop line and the edge with the Crop Colour.
- Reflect – reflects pixels about the current crop line. In other words, it copies pixels from the other side of the current crop line into the area between the current crop line and the screen edge.
- Repeat – copies pixels on the crop boundary to the screen edge.
• Wrap – copies pixels from the area between the opposite crop line and its screen edge to the area between the current crop line and its screen edge.

**Note**  *Horizontal and vertical crop boundaries can have different edge methods, Cropping is often used to remove unwanted pixels at the edge of an image. If a video clip is digitized badly you may get black edges left and right. These can be easily removed by moving the vertical crops and setting the edge method to Reflect.  

**Edge Colour** – sets the fill colour used when the edge method is set to Colour.

**Edge Colour Alpha** – sets the fill colour transparency.

**Left, Right, Top, Bottom** – use these controls to set the crop positions. Lines will be overlaid in the display enabling you to set the various positions by eye.

**Note** *The position of the crop lines can be changed by clicking and dragging them directly on the screen.*
TUTORIAL

Introduction

We have included several tutorials with example images that you can use to practice Keylight.

• Tutorial 1: Simple Key
• Tutorial 2: Fine Tuning a Key
• Tutorial 3: Extreme Blue Spill
• Tutorial 4: A Red Green Screen
• Tutorial 5: Inside & Outside Masks

Example Images

The tutorial images referred to in this chapter can be downloaded from our website www.thefoundry.co.uk.

Tutorial 1: Simple Key

Using the blue screen clip from The Saint, you will composite the actor over the background. You will learn how to:

• Apply Keylight to a layer.
• Pick the Screen Colour.
• View the Final Result.

The clips you will need for this task are called SaintFG.tif and SaintBG.tif, pictures courtesy of CFC and Paramount British Pictures Ltd. for the film The Saint. You should import them
into After Effects and create a new composition containing the blue screen of Elizabeth Shue layered over the road.

Figure 56 is the blue screen foreground that should be

composited over the background shown in Figure 57.
1. Create a new composition using SaintFG.tif and SaintBG.tif, layer the clips with the blue screen over the background as shown in Figure 58.

2. Select the blue screen clip (SaintFG.tif) in the Schematic window and apply Keylight from the Effect - Keying menu. See Figure 59.
3. The Keylight parameters are shown in Figure 60.

![Keylight Parameters](image)

Figure 60. Keylight Parameters.

4. Select the Screen Colour eye dropper and click on the blue screen in the composition window. A good place to pick is the blue from the back windscreen as this has no reflections. See Figure 61.

![Figure 61. Pick the blue from the back windscreen.](image)

5. That’s it. In many cases this is all you will need to do to perform a key, since selecting the screen colour creates a
matte and despills the foreground. The final composite is shown in Figure 62.

Figure 62. Final composite.

There are a couple of extra steps that can be taken to fine tune this key and these are discussed in the next tutorial on page 54.
Tutorial 2: Fine Tuning a Key

Using the images from the film The Saint, you will learn how to fine tune the key pulled in Tutorial 1. You will learn how to:

- Use Status to judge the quality of the key.
- Use the Screen Gain to improve the background.
- Use the Despill Bias to remove more blue spill.

1. Create a new composition using SaintFG.tif and SaintBG.tif. Apply Keylight to the blue screen layer. Select the Screen Colour eye dropper and click on the blue screen in the composition window.

   **Note** These steps were covered in greater detail in the previous chapter.

2. Before we do anything else we need to look at the quality of the key so far. On first inspection, the composite looks pretty good, but it’s hard to judge. To see any potential problems more clearly, switch to the Status view as shown in Figure 63. Here we can see that the windscreens are a mixture of black and grey pixels. The black pixels tell us that pure background will be seen here in the final composite. The grey pixels tell us that there will be a mix of foreground and background pixels. What we want is a clean background showing through the windows, but with
some reflections in the side window preserved. In other words we need mostly black pixels with a few grey ones.

3. Figure 64 on page 55 shows the Status view that we’re aiming for. The background has been cleaned up and we still have some reflections in the side window. To get this you should increase the Screen Gain from 100 to 112.

4. Finally, if you look closely at the composite you will see a tiny amount of blue spill on the woman’s hand and in her hair. This was from reflected light from the blue screen. Pick skin tones for the Despill Bias to remove it.
Tutorial 3: Extreme Blue Spill

This is a really interesting clip from the film Merlin. The results with Keylight are certainly not perfect, indeed it is unlikely that you will ever end up with a truly realistic looking shot. However, there are some interesting things to observe. You will learn how to:

- Reduce the blue spill using Screen Balance and Despill Bias.
- Improve the foreground opacity using Alpha Bias.

1. Load the MerlinBlueFG.tif (Figure 66) and MerlinBlueBG.tif clips and apply Keylight.

![Figure 66. A tricky blue screen.](image)

2. Pick the Screen Colour using the eye dropper.

![Figure 67. Serious blue spill.](image)

Pick a pure blue pixel away from the hair.
3. Increase the Screen Gain from 100 to 105. This will clean up a little of the background.

4. Alter the Screen Balance from 95 to 0 as shown in Figure 68. This step is a bit subjective, but improves the blue spill.

5. Now let’s try and get rid of that blue spill. Switch off Lock Biases Together and pick skin tones for the Despill Bias. When you do this the image and the screen colour will have the blue component scaled up before the key is pulled so that more blue is removed.
6. You will notice that Miranda Richardson’s face now has a number of blue highlights, due to the transparency, that we should fix. The best way to do this is by drawing a spline round the face as shown in Figure 70 and using it as an Inside Mask. Refer to your After Effects guide for more information on masks, however, select the pen tool, draw a bezier spline around the face on frame 1 (Mask 1), switch this mask off () then in keylight set the Inside Mask to Mask 1 and Source to None. You should also soften...
the mask slightly by setting the Inside Mask Softness to 5.

Figure 71. Switch the Mask off.

7. To remove the blue highlights on the cheeks (Figure 72) you need to set the Replace Method to Soft Colour rather than Source.

Figure 72. Replace - Source. Figure 73. Replace - Soft Colour.
8. View Final Result as shown in Figure 74.

Figure 74. Final Key.
Tutorial 4: A Red Green Screen

Using the images from the film Executive Decision, you will learn how to pull a key from a poor green screen using the Despill Bias control. You will learn how to:

- Pick the Screen Colour.
- Use Despill Bias and Alpha Bias.
- Produce a final composite.

The images you will need for this tutorial are called ExecFG.

1. Load the pictures ExecFG.tif (Figure 75) and ExecBG.tif. Apply Keylight. The foreground image is actually a green screen shot although it doesn’t look it. If you analyse the pixels it’s slightly more red than green. To key this we’ll have to fool Keylight.

2. Pick the Screen Colour. You should go for the slightly darker green patch to the left of the pilot. Although feel free to experiment picking different parts of the green screen.
screen. The initial selection gives the result shown in Figure 76.

![Figure 76. Default key.](image)

3. To fix this we need to tell Keylight to scale down the red component to make the green the most dominant so that it keys correctly. To do this pick colours from the mask for both the Despill Bias and Alpha Bias. The result is shown in Figure 77.

![Figure 77. Despill Bias and Alpha Bias.](image)
4. If you look closely, the background and foreground needs cleaning up. Figure 78 shows the Status View. We will use the Screen Matte tools to make the cockpit windows black and the pilot white.

5. Increase Clip Black to 20 to remove some of the foreground showing through the background. Decrease Clip White to 70 to improve the opacity of the foreground. Increase Screen Softness to 1, Screen Despot Black to 2 and Screen Despot White to 2.

6. Use the Screen Matte Replace Method to pull some of the original image through the composite. This improves the...
apparent graininess in the foreground. Figure 80 shows the differences.

Figure 80. Close up view. The left image has Replace Method set to Source. The right image has Replace Method set to None.
Tutorial 5: Inside & Outside Masks

Using the 16 bit blue screen test card image you will learn how to:

- Use Inside and Outside Masks.
- Use the Replace Method to put back keyed out colours.
- Process the Screen Matte.

The clips you will need for this task are called TestCard.cin and ColourGrid.cin

   Import the pictures TestCard.cin (Figure 81) and ColourGrid.cin and put them into the composition layering the blue screen over the colour grid.

Figure 81. Test Card.
2. Apply Keylight to the blue screen layer and pick the blue from the image. Keylight will create a matte and despill the foreground as shown in Figure 82.

3. To remove the garbage around the subject we will use an outside mask. Using After Effects’s masks, draw a spline around the person and test cards. This will be called Mask 1 by default. This is shown as the yellow line in Figure 83.

In the Time Layout window twirl open the TestCard layer and Masks sub-layer and set the compositing mode from Add to None.
4. In Keylight, check that the Outside Mask to Mask 1 and switch Invert on or you’ll be removing the person rather than the unwanted pixels at the screen edges.

5. You will have noticed in Figure 84 the “dirt” around the subject’s head. Clearly we have to improve the key. You can also see the faults in the matte if you view the Status as shown in Figure 85.
6. Increase the Screen Gain to 110. This cleans up some of the background as shown in Figure 86.

Figure 86. Increase Screen Gain.

7. Sections 7 to 10 will cover the changes to the Screen Matte that will improve the key. In the Screen Matte parameter area, decrease the Clip White from 100 to 70.

Figure 87. Clip White.

This will improve the foreground as shown in Figure 87. However, you will notice in the composite that the edges have become a little hard. We can fix this using the Clip Rollback and Screen Softness.
8. Increase the Clip Rollback to 3 and the Screen Softness to

![Figure 88. Rollback and Softness.](image)

1. It's also worth trying to improve the key around the spiky flowers with a sub-pixel erode of the edge. Change Screen Grow/Shrink to -0.5.

9. To remove the foreground spots increase Screen Despot

![Figure 89. Screen Despot Black.](image)

Black to 1. The result is shown in Figure 89.

10. The composite is shown in Figure 90. You will see that the colours of the colour swatches have been altered by
the Keylight algorithm. This can be fixed with an Inside Mask.

11. Draw a rough mask (Mask 2) around just the colour swatches. Set the Inside Mask to Mask 2 and the Replace Method to Source to pull back the original colours.

12. That's it.
APPENDIX A

Release Notes
This appendix describes the requirements, new features, improvements over previous versions, fixed bugs and known bugs and workarounds in Keylight.

Keylight 1.2v8
This is a maintenance release of Keylight to fix a bug. The version of Keylight that ships with AE CS3 Professional is Keylight 1.2v5.

Requirements
Adobe After Effects CS3 Professional on Mac OS X or Windows XP.

Release Date
January 2008

New Features
There are no new features.

Improvements
There are no improvements to existing features.

Fixed Bugs
1. Edge Colour Correction - BUG ID 3176 - colour correction of the edges failed to work. This has been fixed.

Known Bugs and Workarounds
1. About Dialog - on Mac OS X only, launching the About dialog from the Keylight banner and then clicking off the
dialog forces the dialog into the background under the AE application window. Subsequent interaction with After Effects would fail. To get round this, move the After Effects application to one side to reveal the Keylight dialog underneath, then click on the dialog to close it.

2. Multiprocessing - BUG ID 194 - There is a multiprocessing rendering bug shown up as half screen renders. Only seen on Intel PCs with dual core. As a workaround you could temporarily set the environment variable FOUNDARY_MAX_PROCESSORS to 1.

**Keylight 1.2v6**

This is a maintenance release of Keylight to support AE CS3 on Mac and Win. The version of keylight that ships with AE CS3 Professional is Keylight 1.2v5. This release fixes a couple of bugs in that.

**Requirements**

Adobe After Effects CS3 Professional on Mac OS X or Windows XP/Vista.

**Release Date**

5 July 2007

**New Features**

There are no new features.

**Improvements**

There are no improvements to existing features.

**Fixed Bugs**

1. Adaptive Rendering – when scrubbing along the timeline with adaptive rendering switched on, the screen would...
freeze. An interrupt call was being treated as an error and a redraw wasn't called. This has been fixed.

2. About Dialog – clicking on the Keylight banner to show the About dialog, caused the After Effects viewing window to render black. This has been fixed by disabling the ability to launch the dialog from the banner. Click on the standard Adobe "About" text at the top of the plug-in panel instead.

3. Snapshot – BUG ID 231 – snapshot button broken when using Keylight with AE 7. This bug has been fixed in AE CS3.

**Known Bugs and Workarounds**

1. About Dialog – on Mac OS X only, launching the About dialog from the Keylight banner and then clicking off the dialog forces the dialog into the background under the AE application window. Subsequent interaction with After Effects would fail. To get round this, move the After Effects application to one side to reveal the Keylight dialog underneath, then click on the dialog to close it.

2. Multiprocessing – BUG ID 194 – There is a multiprocessing rendering bug shown up as half screen renders. Only seen on Intel PCs with dual core. As a workaround you could temporarily set the environment variable FOUNDRY_MAX_PROCESSORS to 1.

**Keylight 1.2v5**

This is a maintenance release of Keylight to support After Effects CS3. This version ships with AE CS3.

**Requirements**

Adobe After Effects CS3 Professional on Mac OS X or Windows XP/Vista.
New Features
There are no new features.

Improvements
There are no improvements to existing features.

Fixed Bugs
1. Internal version number incremented to enable licensing
to work correctly for the release version of CS3.

Known Bugs and Workarounds
1. Multiprocessing - BUG ID 194 - There is a multiprocessing
rendering bug shown up as half screen renders. Only
seen on Intel PCs with dual core. As a workaround you
could temporarily set the environment variable
FOUNDRY_MAX_PROCESSORS to 1.

Known Bugs with After Effects and Workarounds
1. Snapshot - BUG ID 231 - snapshot buttons broken when
using Keylight with After Effects 7.0. If you apply Keylight
and snapshot the image, change some parameters and
recall that saved snapshot, it is displayed only for a frac-
tion of a second. As a workaround use the Shift-F5 and
F5 keys instead.

Keylight 1.2v4
This is a maintenance release of Keylight to support After
Effects CS3.

Requirements
Adobe After Effects CS3 Professional on Mac OS X or
Windows XP/Vista.
New Features
There are no new features.

Improvements
There are no improvements to existing features.

Fixed Bugs
1. This version of Keylight was compiled against an updated version of the After Effects SDK (7 March 2007).

Known Bugs and Workarounds
1. Multiprocessing - BUG ID 194 - There is a multiprocess- ing rendering bug shown up as half screen renders. Only seen on Intel PCs with dual core. As a workaround you could temporarily set the environment variable FOUNDRY_MAX_PROCESSORS to 1.

Known Bugs with After Effects and Workarounds
1. Snapshot - BUG ID 231 - snapshot buttons broken when using Keylight with After Effects 7.0. If you apply Keylight and snapshot the image, change some parameters and recall that saved snapshot, it is displayed only for a fraction of a second. As a workaround use the Shift-F5 and F5 keys instead.

Keylight 1.2v3
This is a maintenance release of Keylight to support After Effects CS3.

Release Date
Unreleased.
Appendix A

Release Notes

Requirements
Adobe After Effects CS3 Professional on Mac OS X or Windows XP/Vista.

New Features
There are no new features.

Improvements
There are no improvements to existing features.

Fixed Bugs
1. Loading old projects - BUG ID 923 - loading AE7 projects that used Keylight 1.1 into AE8/CS3 with Keylight 1.2 would report a missing plug-in. This bug has been fixed.

Known Bugs and Workarounds
1. Multiprocessing - BUG ID 194 - There is a multiprocess- ing rendering bug shown up as half screen renders. Only seen on Intel PCs with dual core. As a workaround you could temporarily set the environment variable FOUNDARY_MAX_PROCESSORS to 1.

Known Bugs with After Effects and Workarounds
1. Snapshot - BUG ID 231 - snapshot buttons broken when using Keylight with After Effects 7.0. If you apply Keylight and snapshot the image, change some parameters and recall that saved snapshot, it is displayed only for a fraction of a second. As a workaround use the Shift-F5 and F5 keys instead.

Keylight 1.2v2
This is a Windows only maintenance release of Keylight to fix a bug.
Requirements
Adobe After Effects CS3 Professional on Windows XP/Vista only.

New Features
There are no new features.

Improvements
There are no improvements to existing features.

Fixed Bugs
1. SSE2 - BUG ID 801 - the previous version of Keylight was compiled with a sse2 flag preventing it from working on very old hardware running Windows. This version has been recompiled with sse1 to fix this problem affecting a minority of customers.

Known Bugs and Workarounds
1. Multiprocessing - BUG ID 194 - There is a multiprocessing rendering bug shown up as half screen renders. Only seen on Intel PCs with dual core. As a workaround you could temporarily set the environment variable FOUNDRY_MAX_PROCESSORS to 1.

Known Bugs with After Effects and Workarounds
1. Snapshot - BUG ID 231 - snapshot buttons broken when using Keylight with After Effects 7.0. If you apply Keylight and snapshot the image, change some parameters and recall that saved snapshot, it is displayed only for a fraction of a second. As a workaround use the Shift-F5 and F5 keys instead.
Keylight 1.2v1

This is a maintenance release of Keylight to support After Effects CS3.

Requirements
Adobe After Effects CS3 Professional on Mac OS X or Windows XP/Vista.

New Features
1. FLEXlm license support for After Effects Standard.
2. Released as a universal binary for AE CS3 on Mac Intel and PPC.

Improvements
1. The bias controls are now locked together by default.
2. The Keylight algorithm has been tweaked for improved floating point handling.
3. An environment variable (FOUNDRY_MAX_PROCESSORS 1) has been provided to switch off multi-processing as a temporary workaround for Bug ID 194.
4. Keylight is now versioned by name. This allows multiple versions of the plug-in to coexist on a single host.
5. 3GB Switch – the plug-ins have been compiled to take advantage of extended memory available in this mode.

Fixed Bugs
1. Inside Mask, Source Alpha set to Add To Inside Mask.
   When viewing the Status with the source alpha added to the inside mask the combined mattes were not drawn on screen even though the matte had been added. This has been fixed so that the Status correctly shows these combined mattes.
2. Source Crops - BUG ID 224 - changing the left crop value from 0 when X Method is Colour, produces a rendering error in the colour correction edges. This has been fixed.

3. Installer - BUG ID 223 - Keylight could only be installed to the default directory. This has been fixed.

4. Colour Correction Clipping - BUG ID 225 - colour correction of the foreground or edges is incorrectly clipped between 0 and 1 for floating point images. This has been fixed.

**Known Bugs and Workarounds**

1. Multiprocessing - BUG ID 194 - There is a multiprocessing rendering bug shown up as half screen renders. Only seen on Intel PCs with dual core. As a workaround you could temporarily set the environment variable FOUNDARY_MAX_PROCESSORS to 1.

**Keylight 1.1v1**

This is a new release to support After Effects 7.0.

**Requirements**

Adobe After Effects 7.0 Professional on Mac OS X or PC.

**Release Date**

June 2005

**New Features**

1. Support for keying floating point images (32bpc).

**Improvements**

1. The Alpha and Despill Bias controls are now colour widgets rather than sliders. This change extends the range of shots that can be keyed.
2. The default edge method on the Source Crops has been changed to Colour.

**Fixed Bugs**
There are no fixed bugs.

**Known Bugs and Workarounds**
There are no known bugs.

**Keylight 1.0v4**
This is a maintenance release to fix a bug.

**Requirements**
Adobe After Effects 6.0 or 6.5 Professional on Mac OS X or PC.

**Release Date**
8 September 2003

**New Features**
There are no new features.

**Improvements**
1. Installer for Mac OS X changed to standard pkg format. Plug-ins remain the same.

**Fixed Bugs**
1. BUG 354. On PC only, on selecting Edit>Purge>All After Effects will crash. This has been fixed in this release.

**Known Bugs and Workarounds**
1. BUG ID 99 - Keylight would sometimes render only half a frame on multi-processor windows machines only on
After Effects 6.5 only. This did not affect After Effects 6.0 (or After Effects 7.0)

**Keylight 1.0v3**

This version is the full release and is supplied on the Adobe After Effects 6.0 Professional CD.

**Requirements**
Adobe After Effects 6.0 Professional on Mac OS X or PC.

**New Features**
There are no new features.

**Improvements**
There are no new features.

**Fixed Bugs**
1. During a Keylight render, if a redraw of the After Effects user interface occurs, possibly due to a screen saver or window stowing, this may cause Keylight to crash. This bug has been fixed.
2. BUG 346. If Keylight was copied and pasted between compositions, After Effects will crash. This has been fixed.

**Known Bugs and Workarounds**
There are no known bugs.

**Keylight 1.0v2**

**Requirements**
Adobe After Effects 6.0 Professional on Mac OS X or PC.

**New Features**
There are no new features.

**Improvements**

1. A new parameter, "Normal", has been added to the Source Alpha menu to allow embedded alpha to key the layer as normal. This allows multi-shape masks to be used as garbage mattes.

**Fixed Bugs**

There are no fixed bugs.

**Known Bugs and Workarounds**

There are no known bugs.

---

**Keylight 1.0v1**

**Requirements**

Adobe After Effects 6.0 Professional on Mac OS X or PC.

**New Features**

This section will describe new features in later versions.

**Improvements**

This section will describe improvements to existing features in later versions.

**Fixed Bugs**

This section will describe fixed bugs in later versions.

**Known Bugs and Workarounds**

There are no known bugs.
APPENDIX B

End User License Agreement

IMPORTANT: BY INSTALLING THIS SOFTWARE YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT DO NOT INSTALL, COPY OR USE THE SOFTWARE.

This END USER SOFTWARE LICENSE AGREEMENT (this “Agreement”) is made by and between The Foundry Visionmongers Ltd., a company registered in England and Wales, (“The Foundry”), and you, as either an individual or a single entity (“Licensee”).

In consideration of the mutual covenants contained herein and for other good and valuable consideration (the receipt and sufficiency of which is acknowledged by each party hereto) the parties agree as follows:

SECTION 1. GRANT OF LICENSE.

Subject to the limitations of Section 2, The Foundry hereby grants to Licensee a limited, non-transferable and non-exclusive license to install and use a machine readable, object code version of this software program (the “Software”) and the accompanying user guide and other documentation (collectively, the “Documentation”) solely for Licensee’s own internal business purposes (collectively, the “License”); provided, however, Licensee’s right to install and use the Software and the Documentation is limited to those rights expressly set out in this Agreement.

SECTION 2. RESTRICTIONS ON USE.

Licensee is authorized to use the Software in machine readable, object code form only, and Licensee shall not: (a) assign, sublicense, transfer, pledge, lease, rent, share or export the Software, the Documentation or Licensee’s rights hereunder; (b) alter or circumvent the copy protection mechanisms in the Software or reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the Software; (c) modify, adapt, translate or create derivative works based on the Software or Documentation; (d) use, or allow the use of, the Software or Documentation on any project other than a project produced by Licensee (an “Authorized Project”); (e) allow or permit anyone (other than Licensee and Licensee’s authorized employees to the extent they are working on an
Authorized Project) to use or have access to the Software or Documentation; (f) copy or install the Software or Documentation other than as expressly provided for herein; or (g) take any action, or fail to take action, that could adversely affect the trademarks, service marks, patents, trade secrets, copyrights or other intellectual property rights of The Foundry or any third party with intellectual property rights in the Software (each, a "Third Party Licensor"). Furthermore, for purposes of this Section 2, the term "Software" shall include any derivatives of the Software.

Licensee shall install and use only a single copy of the Software on one computer, unless the Software is installed in a "floating license" environment, in which case Licensee may install the Software on more than one computer; provided, however, Licensee shall not at any one time use more copies of the Software than the total number of valid Software licenses purchased by Licensee.

Furthermore, the Software can be licensed on an "interactive" or "non-interactive" basis. Licensee shall be authorized to use a non-interactive version of the Software for rendering purposes only (i.e., on a CPU, without a user, in a non-interactive capacity) and shall not use such Software on workstations or otherwise in a user-interactive capacity. Licensee shall be authorized to use an interactive version of the Software for both interactive and non-interactive rendering purposes, if available.

Finally, if the Software is an "Educational Version," Licensee may use it only for the purpose of training and instruction, and for no other purpose. Educational Versions of the Software may not be used for commercial, professional or for-profit purposes.

SECTION 3. BACK-UP COPY.
Notwithstanding Section 2, Licensee may store one copy of the Software and Documentation off-line and off-site in a secured location owned or leased by Licensee in order to provide a back-up in the event of destruction by fire, flood, acts of war, acts of nature, vandalism or other incident. In no event may Licensee use the back-up copy of the Software or Documentation to circumvent the usage or other limitations set forth in this Agreement.

SECTION 4. OWNERSHIP.
Licensee acknowledges that the Software and Documentation and all intellectual property rights relating thereto are and shall remain the sole property of The Foundry and the Third Party Licensors. Licensee shall not remove, or allow the removal of, any copyright or other proprietary rights notice included in and on the Software or Documentation or take any other action that could adversely affect the property rights of The Foundry or any Third Party Licensor. To the extent that Licensee is authorized to make copies of the Software or Documentation under this Agreement, Licensee shall
reproduce in and on all such copies any copyright and/or other proprietary rights notices provided in
and on the materials supplied by The Foundry hereunder. Nothing in this Agreement shall be deemed
to give Licensee any rights in the trademarks, service marks, patents, trade secrets, copyrights or
other intellectual property rights of The Foundry or any Third Party Licensor, and Licensee shall be
strictly prohibited from using the name, trademarks or service marks of The Foundry or any Third
Party Licensor in Licensee's promotion or publicity without The Foundry's express written approval.

SECTION 5. LICENSE FEE.
Licensee understands that the benefits granted to Licensee hereunder are contingent upon Lic-
ensee's payment in full of the license fee payable in connection herewith (the "License Fee").

SECTION 6. TAXES AND DUTIES.
Licensee agrees to pay, and indemnify The Foundry from claims for, any local, state or national tax
(exclusive of taxes based on net income), duty, tariff or other impost related to or arising from the
transaction contemplated by this Agreement.

SECTION 7. LIMITED WARRANTY.
The Foundry warrants that, for a period of ninety (90) days after delivery of the Software: (a) the
machine readable electronic files constituting the Software and Documentation shall be free from
errors that may arise from the electronic file transfer from The Foundry and/or its authorized
reseller to Licensee; and (b) to the best of The Foundry's knowledge, Licensee's use of the Software
in accordance with the Documentation will not, in and of itself, infringe any third party's copyright,
patent or other intellectual property rights. Except as warranted, the Software and Documentation
is being provided "as is." THE FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRAN-
ties or conditions, express or implied, and The Foundry DISCLAIMS ANY AND ALL IMPLIED
WARRANTIES OR CONDITIONS, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
REGARDLESS OF WHETHER The Foundry KNOWS OR HAS REASON TO KNOW OF LICENSEE'S PARTIC-
ULAR NEEDS. The Foundry does not warranty that the Software or Documentation will meet Lic-
ensee's requirements or that Licensee's use of the Software will be uninterrupted or error free. No
employee or agent of The Foundry is authorized to modify this limited warranty, nor to make addi-
tional warranties. No action for any breach of the above limited warranty may be commenced more
than one (1) year after Licensee's initial receipt of the Software. To the extent any implied warran-
ties may not be disclaimed under applicable law, then ANY IMPLIED WARRANTIES ARE LIMITED IN DURATION TO NINETY (90) DAYS AFTER DELIVERY OF THE SOFTWARE TO LICENSEE.

SECTION 8. LIMITED REMEDY.
The exclusive remedy available to the Licensee in the event of a breach of the foregoing limited warranty, TO THE EXCLUSION OF ALL OTHER REMEDIES, is for Licensee to destroy all copies of the Software, send The Foundry a written certification of such destruction and, upon The Foundry's receipt of such certification, The Foundry will make a replacement copy of the Software available to Licensee.

SECTION 9. INDEMNIFICATION.
Licensee agrees to indemnify, hold harmless and defend The Foundry and The Foundry's affiliates, officers, directors, shareholders, employees, authorized resellers, agents and other representatives (collectively, the "Released Parties") from all claims, defense costs (including, but not limited to, attorneys' fees), judgments, settlements and other expenses arising from or connected with the operation of Licensee's business or Licensee's possession or use of the Software or Documentation.

SECTION 10. LIMITED LIABILITY.
In no event shall the Released Parties' cumulative liability to Licensee or any other party for any loss or damages resulting from any claims, demands or actions arising out of or relating to this Agreement (or the Software or Documentation contemplated herein) exceed the License Fee paid to The Foundry or its authorized reseller for use of the Software. Furthermore, IN NO EVENT SHALL THE RELEASED PARTIES BE LIABLE TO LICENSEE UNDER ANY THEORY FOR ANY INDIRECT, SPECIAL, INCIDENTAL, PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS OR LOSS OF PROFITS) OR THE COST OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, REGARDLESS OF WHETHER THE RELEASED PARTIES KNOW OR HAVE REASON TO KNOW OF THE POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE. No action arising out of or related to this Agreement, regardless of form, may be brought by Licensee more than one (1) year after Licensee’s initial receipt of the Software; provided, however, to the extent such one (1) year limit may not be valid under applicable law, then such period shall limited to the shortest period allowed by law.
SECTION 11. TERM; TERMINATION.

This Agreement is effective upon Licensee’s acceptance of the terms hereof (by clicking on the “Accept” button) and Licensee’s payment of the License Fee, and the Agreement will remain in effect until termination. If Licensee breaches this Agreement, The Foundry may terminate the License granted hereunder by notice to Licensee. In the event the License is terminated, Licensee will either return to The Foundry all copies of the Software and Documentation in Licensee’s possession or, if The Foundry directs in writing, destroy all such copies. In the later case, if requested by The Foundry, Licensee shall provide The Foundry with a certificate signed by an officer of Licensee confirming that the foregoing destruction has been completed.

SECTION 12. CONFIDENTIALITY.

Licensee agrees that the Software and Documentation are proprietary and confidential information of The Foundry and that all such information and any communications relating thereto (collectively, “Confidential Information”) are confidential and a fundamental and important trade secret of The Foundry. Licensee shall disclose Confidential Information only to Licensee’s employees who are working on an Authorized Project and have a “need-to-know” such Confidential Information, and shall advise any recipients of Confidential Information that it is to be used only as authorized in this Agreement. Licensee shall not disclose Confidential Information or otherwise make any Confidential Information available to any other of Licensee’s employees or to any third parties without the express written consent of The Foundry. Licensee agrees to segregate, to the extent it can be reasonably done, the Confidential Information from the confidential information and materials of others in order to prevent commingling. Licensee shall take reasonable security measures, which such measures shall be at least as great as the measures Licensee uses to keep Licensee’s own confidential information secure (but in any case using no less than a reasonable degree of care), to hold the Software, Documentation and any other Confidential Information in strict confidence and safe custody. The Foundry may request, in which case Licensee agrees to comply with, certain reasonable security measures as part of the use of the Software and Documentation. Licensee acknowledges that monetary damages may not be a sufficient remedy for unauthorized disclosure of Confidential Information, and that The Foundry shall be entitled, without waiving any other rights or remedies, to such injunctive or equitable relief as may be deemed proper by a court of competent jurisdiction.

SECTION 13. INSPECTION.

Licensee shall advise The Foundry on demand of all locations where the Software or Documentation is used or stored. Licensee shall permit The Foundry or its authorized agents to inspect all such locations during normal business hours and on reasonable advance notice.
SECTION 14. NONSOLICITATION.
Licensee agrees not to solicit for employment or retention, and not to employ or retain, any of The Foundry’s current or future employees who were or are involved in the development and/or creation of the Software.

SECTION 15. U.S. GOVERNMENT LICENSE RIGHTS.
The Software, Documentation and/or data delivered hereunder are subject to the terms of this Agreement and in no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a minimum, use, duplication or disclosure by the U.S. Government is subject to the applicable restrictions of: (i) FAR §52.227-14 ALTS I, II and III (June 1987); (ii) FAR §52.227-19 (June 1987); (iii) FAR §12.211 and 12.212; and/or (iv) DFARS §227.7202-1(a) and DFARS §227.7202-3.

The Software is the subject of the following notices:

* Copyright (c) 2007 The Foundry Visionmongers, Ltd.. All Rights Reserved.
* Unpublished–rights reserved under the Copyright Laws of the United Kingdom.

SECTION 16. SURVIVAL.
Sections 2, 4, 5, 6, 7, 8, 9, 10, 12, 13, 14, 15, 16, 17 and 18 shall survive any termination or expiration of this Agreement.

SECTION 17. IMPORT/EXPORT CONTROLS.
To the extent that any Software made available hereunder is subject to restrictions upon export and/or reexport from the United States, Licensee agrees to comply with, and not act or fail to act in any way that would violate, the applicable international, national, state, regional and local laws and regulations, including, without limitation, the United States Foreign Corrupt Practices Act, the Export Administration Act and the Export Administration Regulations, as amended or otherwise modified from time to time, and neither The Foundry nor Licensee shall be required under this Agreement to act or fail to act in any way which it believes in good faith will violate any such laws or regulations.
SECTION 18. MISCELLANEOUS.

This Agreement is the exclusive agreement between the parties concerning the subject matter hereof and supersedes any and all prior oral or written agreements, negotiations, or other dealings between the parties concerning such subject. This Agreement may be modified only by a written instrument signed by both parties. If any action is brought by either party to this Agreement against the other party regarding the subject matter hereof, the prevailing party shall be entitled to recover, in addition to any other relief granted, reasonable attorneys’ fees and expenses of litigation. Should any term of this Agreement be declared void or unenforceable by any court of competent jurisdiction, such declaration shall have no effect on the remaining terms of this Agreement. The failure of either party to enforce any rights granted hereunder or to take action against the other party in the event of any breach hereunder shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the event of future breaches. This Agreement shall be governed by, and construed in accordance with English Law.

Copyright (c) 2007 The Foundry Visionmongers Ltd. All Rights Reserved. Do not duplicate.
INDEX

A-Z

A
Advanced Keying 23

B
Basic Keying 17
black pixels
  See Status 20
blue pixels
  See Status 35
blue spill 27
Brightness 44, 46

C
Clip Black 31
Clip Levels 31
Clip Rollback 36
Clip White 31
Colour Balancing 45, 47
Colour Correction 44
Colour Replacement 39
Colour Suppression 45
Computer Film Company 9
Contrast 44, 46
Cropping 47
Crops 47

D
Despill Bias 20
Despot 38

E
Edge Colour Suppression 46
Edge Correction 45
End User License Agreement 83
Erode 38
Example Images 49
eye dropper 17
F
Framestore-CFC 9
G
Getting Started 11
green pixels
  See Status 35
grey pixels
  See Status 20
Grow 38
I
Images
  Downloadable examples 49
Inside Masks 40
Installation
  Windows 5, 6
L
Licensing 6
M
Matte
  Combined Matte 33
Erode 38
Grow 38
Processing 36
Rollback 36
Screen Matte 33, 36
Shrink 38
Status 33
O
Outside Masks 40
R
red pixels
  See Status 35
Release Notes 71
Render Controls
  Colour Correction Edges 33
  Combined Matte 33
  Corrected Source 32
  Final Result 33
  Inside Mask 33
  Intermediate Result 33
  Outside Mask 33
  Screen Matte 33
  Source 32
  Source Alpha 32
  Status 33
Replace Method 39
Requirements 71, 72, 73, 74, 75, 76, 78, 79, 80, 81, 82
Rollback 36
S
Saturation 44, 46
Screen Balance 26
Screen Colour 17, 23
Screen Matte 36
Shrink 38
Source Alpha 42
Status 19
INDEX
A-Z

Status View 33
Suppression 45, 46

T
The Foundry
   About Us 8
Tutorial 49
   images 49
   Introduction 49
   Tutorial 1 49
   Tutorial 2 54
   Tutorial 3 56
   Tutorial 4 61, 70
   Tutorial 5 65

V
View 18, 32

W
   white pixels
   See Status 20